WARNING
For continued protection against fire hazard, replace fuses with those of the same type and rating.

AVERTISSEMENT
Remplacez les fusibles par ceux de même type et puissance pour éviter les risques d’incendie.

WARNING
Most of the chemicals used in peptide synthesis are hazardous. Wear a lab coat, gloves, and eye protection when working with solvents and reagents. Use a fume hood to ensure adequate ventilation.

AVERTISSEMENT
La plupart des produits chimiques utilisés au cours de la synthèse des peptides sont dangereux. Mettez une blouse, des gants et protégez-vous les yeux quand vous manipulez les réactifs et les solvents. Une hotte est indispensable pour une bonne ventilation.
US Safety and EMC (Electromagnetic Compliance) Standards

Safety
This instrument has been tested to and complies with standard ANSI/UL 3101-1, “Electrical Equipment for Laboratory Use; Part 1: General Requirements”, 1st Edition. It is an ETL Testing Laboratories listed product.

EMI
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Warning: Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Note: Shielded cables must be used with this unit to ensure compliance with the Class A FCC limits.
Canadian Safety and EMC (Electromagnetic Compliance) Standards

Safety
This instrument has been tested to and complies with standard CSA 1010-1, “Safety Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use; Part 1: General Requirements”. It is an ETL Testing Laboratories listed product.

Sécurité
Cet instrument a été vérifié avec la norme C22.2 No. 151, «Spécifications de sécurité du matériel électrique utilisé pour les mesures, les contrôles et dans les laboratoires : Partie 1 : Spécifications générales», et il est conforme à cette norme. C’est un produit homologué par les ETL Testing Laboratories.

EMI
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
# European Safety and EMC (Electromagnetic Compliance) Standards

**Declaration of Conformity**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>89/336/EEC “Electromagnetic Compatibility”</td>
</tr>
<tr>
<td>Standard(s) to which conformity is declared:</td>
<td>EN61010-1 “Safety Requirements for Electrical Equipment for Measurement, Control and Laboratory Use”</td>
</tr>
<tr>
<td></td>
<td>EN55011:1991, Group 1, Class B “Radiated Emissions”</td>
</tr>
<tr>
<td></td>
<td>EN50082-1:1991 “Generic Immunity”</td>
</tr>
<tr>
<td>Manufacturer’s Name:</td>
<td>Applied Biosystems</td>
</tr>
<tr>
<td>Manufacturer’s Address:</td>
<td>500 Old Connecticut Path</td>
</tr>
<tr>
<td></td>
<td>Framingham, Massachusetts 01701 USA</td>
</tr>
<tr>
<td>Type of Equipment:</td>
<td>Laboratory Instrumentation</td>
</tr>
<tr>
<td>Model Name &amp; Number:</td>
<td>Multiple Peptide Synthesis Accessory</td>
</tr>
<tr>
<td>Model Number</td>
<td>GEN600616</td>
</tr>
<tr>
<td>Serial Number:</td>
<td>FX7CM0001M and later</td>
</tr>
<tr>
<td>Year of Manufacturer:</td>
<td>1997 and later</td>
</tr>
</tbody>
</table>
Table of Contents

How to Use This Guide ........................................................................................................ ix

Chapter 1  Introducing the Multiple Peptide Synthesis Accessory

1.1  Introducing the MPS Accessory .................................................................................. 1-2
1.2  Parts of the MPS Accessory ......................................................................................... 1-4
1.3  Disabling and Enabling the MPS Accessory ............................................................. 1-5

Chapter 2  Performing a Synthesis

2.1  Overview ....................................................................................................................... 2-2
2.2  Using the MPS Notebook ............................................................................................... 2-3
   2.2.1 Creating or Opening an MPS Notebook ................................................................. 2-4
   2.2.2 Entering the Synthesis Parameters ....................................................................... 2-6
   2.2.3 Entering the Sequence ......................................................................................... 2-7
   2.2.4 Entering Comments ............................................................................................. 2-11
   2.2.5 Viewing and Printing the Multiple Peptide Synthesis Calculation Sheet .......... 2-12
   2.2.6 Sending the MPS Notebook to the Pioneer Peptide Synthesis System .............. 2-14
2.3  Preparing the Columns ................................................................................................. 2-16
   2.3.1 Selecting and Assembling Columns .................................................................... 2-16
   2.3.2 Packing Columns ................................................................................................. 2-18
2.4  Preparing the System .................................................................................................... 2-19
   2.4.1 Checking the MPS Calibration ............................................................................ 2-20
   2.4.2 Checking and Updating the Reagent Resources .................................................. 2-21
   2.4.3 Installing the Amino Acids ................................................................................... 2-23
   2.4.4 Priming ................................................................................................................. 2-25
   2.4.5 Installing the Columns ......................................................................................... 2-28
   2.4.6 Emptying Waste .................................................................................................... 2-31
How to Use This Guide

Purpose of this guide

Applied Biosystems Pioneer™ Multiple Peptide Synthesis Accessory User’s Guide details the procedures for using and troubleshooting the Pioneer Multiple Peptide Synthesis (MPS) accessory in conjunction with the Pioneer™ Peptide Synthesis System. Use this guide in conjunction with the manuals listed on page xii which are provided with your system and workstation software.

Audience

This guide is intended for novice and experienced Pioneer Multiple Peptide Synthesis accessory users.

Structure of this guide

Applied Biosystems Pioneer™ Multiple Peptide Synthesis Accessory User’s Guide is divided into chapters. Each chapter page is marked with a tab and a header to help you locate information within the chapter.

The table below describes the material covered in each chapter.

| Chapter 1, Introducing the Multiple Peptide Synthesis Accessory | Describes the features, parts, and functions of the MPS accessory. Also describes how to disable the MPS accessory if you want to use a single column on the Pioneer Peptide Synthesis System in place of the MPS accessory. |
| Chapter 2, Performing a Synthesis | Provides the following procedures:  
• Preparing an MPS notebook and sending it to the system  
• Assembling and packing the columns  
• Installing the reagents and columns  
• Starting the syntheses and viewing the status during operation |
<table>
<thead>
<tr>
<th>Chapter 3, Viewing and Printing Reports</th>
<th>Provides procedures for viewing Multiple Peptide Synthesis reports and printing a summary report or separate reports for each column.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 4, Troubleshooting</td>
<td>Provides steps to take to resolve hardware problems and correct error codes.</td>
</tr>
<tr>
<td>Appendix A, Specifications</td>
<td>Includes MPS specifications at the 0.05 mmole scale.</td>
</tr>
<tr>
<td>Appendix B, Spare Parts</td>
<td>Contains information for ordering spare parts.</td>
</tr>
<tr>
<td>Appendix C, Warranty/Service Information</td>
<td>Contains warranty, service, and return information.</td>
</tr>
<tr>
<td>Appendix D, MPS Calibration</td>
<td>Describes the MPS calibration value, how to determine this value for your system, and how reset this value.</td>
</tr>
<tr>
<td>Appendix E, Technical Support and Training</td>
<td>Describes how to contact Technical Support, obtain technical documents, and obtain information regarding customer training.</td>
</tr>
</tbody>
</table>
**Conventions**

*General conventions*

- **Bold** indicates user action:
  
  “Type 0 and press Enter for the remaining fields.”

*Notes, Cautions, and Warnings*

A note calling out important information to the operator appears as:

**NOTE**: Record your result before proceeding with the next step.

A caution calling out information to avoid damage to the system or loss of data appears as:

**CAUTION**

*Do not touch the lamp. This may damage the lamp.*

A warning calling out information essential to the safety of the operator appears as:

**WARNING**

*The tip of the probe is very sharp. Use caution when working with the probe.*
Related documentation

These related documents are provided with the Pioneer Peptide Synthesis System:

- Applied Biosystems **Pioneer™ Peptide Synthesis System Getting Started Guide** — Use this guide to learn the basics of operating the system. It provides step-by-step information for running your first experiment.

- **Applied Biosystems Pioneer™ Peptide Synthesis System User’s Guide** — Use this guide for detailed information about operating, maintaining, and troubleshooting the Pioneer Peptide Synthesis System. This guide also contains theoretical information about solid phase peptide synthesis.

This related document is provided with the Pioneer Workstation Software:

- **Applied Biosystems Pioneer™ Workstation Software Getting Started Guide** — Use this guide to learn how to use the Pioneer Workstation Software with the Pioneer Peptide Synthesis System to perform syntheses.
Introducing the Multiple Peptide Synthesis Accessory

This chapter includes the following sections:

1.1 Introducing the MPS Accessory ................. 1-2
1.2 Parts of the MPS Accessory ..................... 1-4
1.3 Disabling and Enabling the MPS Accessory ........................................ 1-5
1.1 Introducing the MPS Accessory

**Overview**  The Pioneer™ Multiple Peptide Synthesis (MPS) accessory is a column expansion module for the Pioneer Peptide Synthesis System. The MPS accessory allows you to synthesize up to 16 peptides simultaneously. You can use two MPS accessories with a Pioneer Peptide Synthesis System to expand the synthesis capability up to 32 peptides.

You can place the MPS accessory beside or on top of the Pioneer Peptide Synthesis System. When you place the MPS accessory on top of the system, no additional bench space is needed. Figure 1-1 show an MPS accessory on top of a Pioneer Peptide Synthesis System.

![Figure 1-1  Pioneer System with MPS Accessory](image)

You use the Pioneer Workstation software to operate the MPS accessory.
**Features** Each MPS accessory provides:

- Expansion of each column position to 16 columns
- Unattended simultaneous synthesis of up to 16 sequences
- Accommodation of up to 23 pre-dissolved amino acids
1.2 Parts of the MPS Accessory

**Components**

The MPS accessory includes:

- MPS column expansion module
- Pioneer Peptide Synthesis System software version 1.4 or later
- Pioneer Workstation software version 1.1 or later
- Wash station

**Initial installation**

The MPS accessory must be installed on the Pioneer Peptide Synthesis System by an Applied Biosystems Service Representative.

The Service Representative installs appropriate fluidic, electronic, power, and communications connections between the MPS accessory and the Pioneer Peptide Synthesis System. Each MPS accessory is configured to take the place of one column on your Pioneer Peptide Synthesis System.

Note the column position to which the MPS accessory is configured. If you disconnect the MPS accessory and want to reconnect it, you must reconnect it to the same column position configured during initial installation.

**Reconfiguring the MPS accessory**

If you want to remove the MPS accessory from one column position on the system and connect it to the other column position, contact your Applied Biosystems Service Representative for assistance.

**Workstation control**

You control the MPS accessory with the Pioneer Workstation software. For detailed information about the Workstation software, see the *Pioneer Workstation Software Getting Started Guide*. 
1.3 Disabling and Enabling the MPS Accessory

Disabling the MPS accessory

If you want to use a column in place of the MPS accessory you must disable the MPS accessory.

You disable the MPS accessory by:

- Changing the MPS Option setting in System Settings of the User Profile in the system software
- Disconnecting the MPS tubing from the system

Changing the MPS Option setting

To change the MPS Option setting:

1. On the system display, press Tools on the Main menu.
   The Tools display appears.

2. Press Config.
   The Tools-Config menu appears (Figure 1-2).

   Figure 1-2 Tools : Config Menu

   The Tools-Config : Profile # display appears (Figure 1-3).
4. Press **Edit**.

   The Synthesis Parameters 1 : Profile# display appears (Figure 1-4).

   ![Figure 1-4 Synthesis Parameters 1 : Profile#](image)

5. Press **More** three times.

   The System Settings 1 : Profile# display appears (Figure 1-5) with Yes displayed under the column position to which the MPS accessory is connected.

   ![Figure 1-5 System Settings 1 : Profile#](image)
Disabling and Enabling the MPS Accessory

6. Set the MPS Option to **No** on the appropriate column position.

   **NOTE:** If you set the MPS Option to Yes, you cannot change the tube size. When using the MPS accessory, you must use large 28 mm tubes for the amino acids.

7. Press **Exit**.
   You are prompted: Save Modified Profile?

8. Press **ok**.
   The MPS accessory is disabled for the user profile.

9. Restart the Pioneer System and reboot the Workstation software after disabling the MPS accessory.
**Chapter 1  Introducing the Multiple Peptide Synthesis Accessory**

**Disconnecting the tubing**

To disconnect the tubing from the system:

1. Disconnect the tubing from the MPS connector on the front panel of the Pioneer Peptide Synthesis System (Figure 1-6).

2. Put a plug in the MPS connector.

3. Connect the tubing to the bottom of the system column.

---

**Figure 1-6  MPS Front Panel Connection**
Enabling the MPS accessory

To enable the MPS accessory for use instead of a single column:

1. Access the System Settings 1 display. Follow step 1 through step 5 of “Changing the MPS Option setting” on page 1-5.

2. Set the MPS Option to Yes on the appropriate column position.

   The software automatically toggles Tube Size to Large.

   **NOTE:** When using the MPS accessory, you must use large 28 mm tubes for the amino acids.

3. Press Exit.

4. Connect the tubing from the bottom of the system column to the MPS connector on the front panel of the Pioneer Peptide Synthesis System (Figure 1-6). Make sure to connect the tubing to the column for which the MPS accessory was configured during initial installation.

5. Restart the Pioneer System and reboot the Workstation software after disabling the MPS accessory.
Chapter 1  Introducing the Multiple Peptide Synthesis Accessory

1-10  Applied Biosystems
Performing a Synthesis

This chapter contains the following sections:

2.1 Overview .................................................. 2-2
2.2 Using the MPS Notebook ............................. 2-3
2.3 Preparing the Columns .............................. 2-16
2.4 Preparing the System ............................... 2-19
2.5 Starting Syntheses and Monitoring the Status ............. 2-32
2.6 Removing the Columns and the Support .............. 2-34
This section describes the procedure for synthesizing a set of sequences on the Pioneer Peptide Synthesis System using the MPS accessory.

The MPS accessory allows you to perform syntheses on up to 16 columns. You specify the synthesis parameters for the columns using the MPS notebook in the Pioneer Workstation software.

**Synthesis steps**

Performing a synthesis using the MPS accessory is similar to standard synthesis. The steps are:

- Define the sequences in the MPS notebook
- Print the Peptide Synthesis Calculation Sheet
- Send the MPS notebook to the system
- Prepare the columns
- Prepare the system
- Start the synthesis
- Monitor the synthesis
- Remove the support from the column
2.2 Using the MPS Notebook

Overview

The MPS Notebook window is similar to the standard Pioneer Notebook window. The MPS Notebook window allows you to define a set of sequences and enter the parameters necessary to perform syntheses on the MPS columns. You enter the following information in the MPS Notebook window:

- Protocol
- Chemistry
- Scale
- Cycle
- Activator
- Final Cycle option
- Sequence Name
- C-Terminus option
- First AA option
- Sequences
- Comments

All sequences are synthesized using the same protocol, chemistry, scale, cycle, activators, and final cycle. You set the C-terminus option and whether the first amino acid is on or off the support for each sequence individually.
2.2.1 Creating or Opening an MPS Notebook

You can prepare an MPS notebook in four ways:

- Create a blank MPS notebook
- Copy an existing MPS notebook and edit it
- Open an existing MPS notebook and edit it
- Import an exported MPS notebook and edit it

Creating

To create an MPS notebook:

1. Start the Pioneer Workstation software.
   
   See Pioneer Workstation Software Getting Started Guide for more information.

2. In the Database window, click File, point to New, and then click MPS Notebook.
   
   The MPS Notebook icon appears.

3. Type a name and press Enter.

4. Double-click the associated MPS Notebook icon.
Using the MPS Notebook

The MPS Notebook window appears (Figure 2-1).

**Figure 2-1 MPS Notebook Window**

**Copying** To copy an existing MPS notebook to edit, make a copy in the Database window and open the copy. See the *Pioneer Workstation Software Getting Started Guide* for more information.

**Opening** To open an existing MPS notebook, double-click the associated MPS Notebook icon in the Database window.

**NOTE:** Do not open and edit an MPS notebook that is running. Copy the notebook before editing.
Chapter 2  Performing a Synthesis

**Importing**  
To import an MPS notebook that was exported to a stand-alone file (.MBK), in the Database window, open a new MPS notebook, then select **Import** from the File menu.

See the *Pioneer Workstation Software Getting Started Guide* for more information.

### 2.2.2 Entering the Synthesis Parameters

**MPS protocol**  
A protocol is a set of instructions that control the operation of the system during a peptide synthesis. The protocol scales the reagents to the appropriate volumes for the selected MPS column size.

A protocol named MPS Template is provide with the Pioneer Workstation software.

**Editing the protocol**  
You cannot edit the factory-provided MPS Template protocol. If you want to make changes to the MPS Template protocol, you first have to make of copy of the protocol.

See the *Pioneer Workstation Software Getting Started Guide* for information to edit, copy, and modify an MPS protocol.

When you edit an MPS protocol, note the following:

- Do not change any steps except the deblocking and coupling times, unless you have a thorough knowledge of the protocol and system.

- Do not edit steps that affect the positioning of reagents on the column.

**Editing the chemistry**  
If you want to create a chemistry that is not available in the list or edit a chemistry, use the Chemistry Editor.

See the *Pioneer Workstation Software Getting Started Guide* for more information.
**Entering the parameters**

To enter the synthesis parameters in the MPS notebook (Figure 2-1):

1. Select the desired **MPS protocol** from the Protocol drop-down list.
2. Select the **Chemistry** from the Chemistry drop-down list.
3. Type a **scale** (0.025, 0.05, 0.1 mmole) in the Scale text box.
4. Select the **Cycle** from the Cycle drop-down list.
5. Select the **Activator** from the Activator drop-down list.
6. Select the **Final Cycle** option.

### 2.2.3 Entering the Sequence

**Overview**  
You can enter the sequence for each MPS column in three ways:
- Create a sequence using the sequence view
- Copy or cut an existing sequence from an MPS column in an MPS notebook
- Copy an existing sequence from the database

**Creating**  
To create a new sequence:

1. Click an **MPS Column** button (a through p).
2. Click the **Sequence View** button.
   The sequence view appears (Figure 2-2).
3. Type the **sequence name** in the Name text box.
Chapter 2   Performing a Synthesis

Figure 2-2  MPS Sequence View

4. Type the sequence, starting with the N-terminus amino acid.

5. Click the MPS Notebook View button .
   The MPS Notebook view appears with the sequence name and sequence displayed to the right of the selected MPS column (a through p).

Figure 2-3  MPS Notebook with Sequence

6. Select the C-Terminus option (Acid or Amide) from the drop-down list.
7. Select the First AA option (On Support or Off Support) from the drop-down list.

**NOTE:** If you select On Support, do not enter = (recouple) as the amino acid preceding the C-terminus. If you select Off Support, do not enter = (recouple) as the C-terminal amino acid.

8. Repeat step 2 through step 7 for each column.

**NOTE:** You can create sequences for columns in any order. You do not need to select the columns in order.

---

**Copying or cutting from MPS notebook**

To copy or cut a sequence from another MPS column in an MPS notebook or from a sequence file:

**NOTE:** Do not use Export or Import to copy or cut a sequence. These commands export and import the entire MPS Notebook, not just the sequence.

1. Click the MPS Column button (a through p) that contains the sequence you want to copy.

**NOTE:** The sequence can be in the MPS notebook you are editing or another open MPS notebook.

2. Select **Copy** or **Cut** from the Edit menu.

3. Click the MPS Column button (a through p) to which you want to paste the sequence.

4. Select **Paste** from the Edit menu.

   The copied or cut sequence is pasted into the MPS column position.

5. Select the **C-Terminus** option (Acid or Amide) from the drop-down list.

6. Select the **First AA** option (On Support or Off Support) from the drop-down list.
Chapter 2 Performing a Synthesis

Copying from database

To copy an existing sequence from the database:
1. Click an MPS Column button (a through p).
2. Click the Copy Sequence from Database button.

The Copy From Sequence dialog box appears.
3. Select the sequence and click OK.
4. Select the C-Terminus option (Acid or Amide) from the drop-down list.
5. Select the First AA option (On Support or Off Support) from the drop-down list.
6. Repeat step 1 through step 5 for each column.

NOTE: You can copy sequences for columns in any order. You do not need to select the columns in order.

Verifying sequence with audio playback

After creating a sequence, you can listen to audio playback to verify the sequence. For more information, see the Pioneer Workstation Software Getting Started Guide.

Deleting a sequence

To delete a sequence, select the MPS column, then click the Clear button or press the Delete key.

Autofilling C-Terminus and First AA options

After entering or copying sequences, you can autofill the C-Terminus options (Acid or Amide) and First AA options (On Support or Off Support):
1. Click an MPS Column button (a through p) and select the C-Terminus option (Acid or Amide) or First AA option (On Support or Off Support) from the drop-down list.
2. Click the right mouse button and select Fill Column from the menu.

The selected option is entered for all MPS columns below the selected MPS column.
2.2.4 Entering Comments

You can enter comments that appear in the Notebook description field on the MPS report.

To enter comments:

1. From the MPS Notebook window, select Properties from the File menu or click the Properties button.

   The General parameters appear (Figure 2-4).

   ![Figure 2-4 General Parameters]

2. Type the comment in the Comment box.

3. Click OK.
2.2.5 Viewing and Printing the Multiple Peptide Synthesis Calculation Sheet

The Multiple Peptide Synthesis Calculation Sheet contains the parameters you entered in the MPS notebook and the following information:

- Scale parameters
- Support parameters
- Peptide length, molecular weight, and theoretical yield
- Amino acid weights and solvent volumes
- Reagent consumption, waste generation, and synthesis time estimate
- Comments

**Viewing**

To view the Multiple Peptide Synthesis Calculation Sheet:

1. Do one of the following:
   - Select **Resources** from the View menu
   - In the Notebook window, click the Resource view button

   The Multiple Peptide Synthesis Calculation Sheet appears.

2. To zoom in, click the magnifying glass pointer on the area to magnify.

3. To return to the previous magnification, click the **Zoom Out** button.
**Printing**  You can print the Multiple Peptide Synthesis Calculation Sheet from two places:

<table>
<thead>
<tr>
<th>To print from the...</th>
<th>Do this ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Peptide Synthesis Calculation Sheet screen</td>
<td>Click <strong>Print</strong>.</td>
</tr>
<tr>
<td>MPS Notebook window</td>
<td>• Select <strong>Print</strong> from the File menu. The Print dialog box appears.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>OK</strong>.</td>
</tr>
</tbody>
</table>
2.2.6 Sending the MPS Notebook to the Pioneer Peptide Synthesis System

To send the MPS notebook to the system:

**NOTE:** Add any comments that you want to appear in the report to the MPS notebook before you send it to the system. See Section 2.2.4, Entering Comments.

1. In the MPS Notebook window, select **Send** from the File menu or click ![Send Button].

   The Send dialog box appears (Figure 2-5).

   ![Send Dialog Box](image)

   **Figure 2-5 Send Dialog Box**

2. Select the column position to which the MPS is connected, and click **OK**.

   The Synthesis Checklist Wizard appears.
3. Verify that you have completed steps on the checklist before you start the synthesis:

<table>
<thead>
<tr>
<th>If you want ...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>the software to prompt you through the steps in the checklist.</td>
<td>Click <strong>Next</strong>. Follow the prompted procedures.</td>
</tr>
<tr>
<td>to close the checklist.</td>
<td>• Click <strong>Cancel</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Prepare the system for synthesis by following the procedures in</td>
</tr>
<tr>
<td></td>
<td>Section 2.3, Preparing the Columns and</td>
</tr>
<tr>
<td></td>
<td>Section 2.4, Preparing the System.</td>
</tr>
</tbody>
</table>

*Disabling the checklist* If you do not want to display the Synthesis Checklist Wizard in the future, deselect Show Synthesis Checklist in the Send dialog box (Figure 2-5).
Chapter 2  Performing a Synthesis

2.3 Preparing the Columns

Applied Biosystems recommends using our disposable column assemblies on the MPS accessory. See Appendix B, Spare Parts, for ordering information.

This section contains the following procedures:
- Selecting and assembling columns
- Packing columns
- Installing columns

2.3.1 Selecting and Assembling Columns

Selecting

To select an MPS column size:

1. Determine the amount of support (for example, PEG-PS™) needed:

   \[ \text{Weight of Support (g)} = \frac{\text{Synthesis Scale}}{\text{Loading Factor}} \]

   \( \text{NOTE: To determine Loading Factor (mmole/g) for your support, check the label on the bottle.} \)

2. Select a column adequate for the amount of support you will be using:

<table>
<thead>
<tr>
<th>Column Size (mmole)</th>
<th>Maximum Amount of Support (g)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.025 (two grooves on the top and bottom of column)</td>
<td>0.2</td>
</tr>
<tr>
<td>0.050 (no grooves on column)</td>
<td>0.4</td>
</tr>
<tr>
<td>0.100 (one groove on the middle of column)</td>
<td>0.8</td>
</tr>
</tbody>
</table>
Assembling

To assemble an MPS column:

1. Place an end-piece with a frit over one column end (Figure 2-6).

   **NOTE:** You will place the other end-piece and frit over the other column end after packing the column.

2. Place a crimp cap over the end-piece on the column.

3. Crimp the crimp cap over the end-piece and column using a crimp tool.

4. Make sure that you cannot rotate the end-piece. If you can rotate the end-piece, crimp the crimp cap again.
2.3.2 Packing Columns

To pack an MPS column:

1. Determine the amount of support needed:
   Weight of Support (g) = Synthesis Scale / Loading Factor

   **NOTE:** To determine Loading Factor (mmole/g) for your support, check the label on the bottle.

2. Weigh the support (for example, PEG-PS™) and transfer it to the column you assembled in the previous procedure. Wipe any support from the inside lip of the column.

3. Place an end-piece with a frit over the open column end.

4. Place a crimp cap over the end-piece.

5. Crimp the crimp cap over the end-piece and column using the crimp tool.

6. Make sure that you cannot rotate the end-piece. If you can rotate the end-piece, crimp the crimp cap again.
2.4 Preparing the System

Prepare the system to perform the syntheses by:

- Checking the MPS calibration
- Checking and updating the reagent resources
- Installing the amino acids
- Priming
- Installing the columns
- Emptying waste

The Multiple Peptide Synthesis Calculation Sheet contains reagent requirements and the order and dilution information for the amino acids. If you do not have a Multiple Peptide Synthesis Calculation Sheet, print one now to refer to when performing the following procedures.

To print the Multiple Peptide Synthesis Calculation sheet:

1. In the MPS Notebook window, select Print from the File menu.

   The Print dialog box appears.

2. Click OK.

   The Multiple Peptide Synthesis Calculation Sheet prints.
2.4.1 Checking the MPS Calibration

The MPS calibration value is determined and set for your instrument when it is initially installed by an Applied Biosystems Service Representative.

**NOTE:** Record this MPS calibration value so you have it available if you need to check or reset the MPS calibration value.

To check the MPS calibration value:
1. On the system display, press **Tools** on the Main menu.
2. Press **Diag**. Press **MPS**.
   
   The value next to **Current** is the MPS calibration value.

For more information on determining and resetting the MPS calibration value, see Appendix D, MPS Calibration.
2.4.2 Checking and Updating the Reagent Resources

Make sure the reagents installed on the system are adequate for the syntheses. Compare the required reagent volumes with the current reagent volumes, and replenish reagents as needed. If you replenish a reagent, be sure to reset the volume.

To check the reagent resources:

1. Select Go to Instrument from the Window menu or click the Instrument button.
   The Instrument window appears.

2. Select Properties from the File menu or click the Properties button.
   The Properties dialog box appears.

3. Click the Reagent tab.
   The Reagent parameters appear (Figure 2-7).

![Figure 2-7 Reagent Parameters](image-url)
Chapter 2  Performing a Synthesis

4. Check the volume in the Required and Quantity columns. If the volume in the Required column is more than the volume in the Quantity column, add reagent to a bottle. A > symbol (greater than) between the Required and Quantity columns, also indicates the volume is insufficient. See the *Pioneer Peptide Synthesis System User’s Guide*, Section 4.5, Installing the Reagents for more information.

5. If you add reagent to a bottle, reset the volume by doing one of the following:

   • If a bottle is filled to the standard volume, click the volume button under the Standard Kit column for the appropriate reagent.

   • If the bottle is filled to a custom volume, type the volume (ml) in the Quantity text box.

   _______________

   NOTE: To undo the changes you made, click the Revert button.

   _______________

6. To print a list of the resources, click Print.

7. To return to the Instrument window, click OK.
2.4.3 Installing the Amino Acids

**Overview**
For multiple syntheses using the MPS accessory, you must install pre-dissolved amino acids in fixed positions. The Pioneer Peptide Synthesis System delivers the amino acids to the appropriate columns as defined by the sequences in the MPS notebook.

**Preparing amino acids**
For each amino acid, the Pioneer Workstation software calculates:
- The weight of amino acid needed
- The volume of solvent needed to prepare a 0.5 M dilution

The weights and volumes required are included in the Multiple Peptide Synthesis Calculation Sheet.

To prepare the amino acids:
1. Weigh out the amino acids into large tubes.
2. Dissolve the weighed amino acids with the solvent volumes given on the sheet.

**NOTE:** When using the MPS accessory, you must use large 28 mm tubes for the amino acids.
Installing  Install the amino acids in large tube racks in the Transport System (Figure 2-8). Install the tubes in the order shown on the Multiple Peptide Synthesis Calculation Sheet.

**NOTE:** The amino acids are usually arranged in the Amino Acid Transport in alphabetical order according to the single-letter code. If any amino acid requires more than one tube, additional tubes are assigned by the software.

**Figure 2-8 Amino Acid Rack Positions for Large Tubes**
2.4.4 Priming

When to prime  Always prime before starting a synthesis.

There are two priming procedures. The following table explains when to perform each priming procedure:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>When to Perform</th>
</tr>
</thead>
</table>
| Priming the Pioneer System and MPS accessory (see page 26) | • It has been more than 12 hours since the last synthesis  
|                                                 | • You interrupted a synthesis                            
|                                                 | • You added or replenished reagents                      |
| Priming the MPS accessory only (see page 30)     | It has been less than 12 hours since the last synthesis  |

Before you begin  Before you prime, make sure you enable the MPS accessory. For more information, see “Enabling the MPS accessory” on page 1-9.
To prime the Pioneer System and MPS accessory:

1. On the system display, press **Prime** on the Main menu.
   The Prime menu appears.

2. Press **More**.
   The second Prime menu appears (Figure 2-9).

3. Press **9 - MPS System prep**.
   The Prime display appears (Figure 2-10).

4. Press the column position to which your MPS accessory is connected, **Column 1** or **Column 2**.
   The Position Selection display appears (Figure 2-11).
5. Using the arrow keys, toggle the position selection to **All** and press **ok**.

   The system prompts: Put wash station in AAT.

6. If the wash station is not in the sampling position under the probe, press **Stop**, then **End** to position the wash station. Press **Repeat**.

   If the wash station is in the sampling position under the probe, continue to step 7.

7. Press **ok**.

   The system prompts: Put union in column positions.

8. Replace all columns with unions and press **ok**.

   The system primes the reagent lines, washes the probe, primes the line to the MPS accessory, and primes the 16 column lines. During the prime, the current action appears on the screen. If you want to stop the priming procedure, press the **Stop** key.

   **NOTE:** During the prime, you can press **Info** to toggle through the system statistics: Step Time, Fluid Pressure, Blanket Pressure, Flow Count, and Detector Output.

   The system prompts: Load columns.

   Load or install the columns using the procedure described in Section 2.4.5, Installing the Columns, and complete the prime.
2.4.5 Installing the Columns

You can install up to 16 MPS columns on each MPS accessory.

**Column positions**

The column positions are labeled a through p as shown in Figure 2-12.

![Column Positions Diagram](attachment://column_positions.png)

**Column connections**

Each column is connected to an associated piece of tubing and fitting. Figure 2-13 shows an MPS accessory with 16 columns installed.

![MPS Accessory with Columns Installed](attachment://mps_accessory_columns_installed.png)
Installing

To install the columns:

1. Remove the union from the column position. Place the union on the pin in front of the column position.

2. Firmly insert the column over the bottom fitting on the base of the MPS accessory. Use a slight twisting motion—about one-quarter turn clockwise.

   **NOTE:** The columns are bidirectional. You can insert either end of the column on the fitting.

3. Insert the top fitting into the top of the column. Use a slight twisting motion—about one-quarter turn clockwise.

Completing the prime

To complete the prime:

1. Press **ok**.

   The system primes the columns.

2. Check the columns for leaks. If you find any leaks, recrimp or replace the crimp caps and prime the MPS columns as described in “Priming the MPS accessory only” on page 2-30.

3. When priming is finished, press **Cancel** and then press **Exit** to return to the system Main menu.
To prime the MPS accessory only:

1. On the system display, press **Prime** on the Main menu.
2. Press **More**.

The second Prime menu appears (Figure 2-14).

![Figure 2-14 Prime Menu](image)

3. Press **10 - MPS Column prep**.

The Prime display appears (Figure 2-15).

![Figure 2-15 Prime Display](image)

4. Press the column position to which your MPS accessory is connected, **Column 1** or **Column 2**.

The Position Selection display appears (Figure 2-16).

![Figure 2-16 Position Selection Display](image)
5. Using the arrow keys, toggle the position selection to **All** and press **ok**.

   The system prompts: Put union in column positions.

6. Replace all columns with unions and press **ok**.

   The system primes the line to the MPS accessory and the 16 column lines. During the prime, the current action appears on the screen. If you want to stop the priming procedure, press the **Stop** key.

   **NOTE:** During the prime, you can press **Info** to toggle through the system statistics: Step Time, Fluid Pressure, Blanket Pressure, Flow Count, and Detector Output.

   The system prompts: Load columns.

   Load or install the columns using the procedure described in Section 2.4.5, Installing the Columns, and complete the prime.

### 2.4.6 Emptying Waste

Empty the waste container before starting syntheses to accommodate the waste generated by MPS syntheses.
2.5 Starting Syntheses and Monitoring the Status

**Starting**

To start the syntheses on the MPS columns:

On Pioneer Peptide Synthesis System display Main menu, press the **Strt key** that corresponds to the column position to which the MPS accessory is connected.

The syntheses start and the following occur:

- The first step in the protocol is performed on the first MPS column.
- The first step in the protocol is then performed on each additional MPS column sequentially.
- All remaining steps in the protocol run on each column sequentially until the protocol is complete.

**Monitoring the status**

You monitor the status of the MPS syntheses the same way you monitor a standard synthesis, except you cannot view the Fmoc monitor or histogram.


**NOTE:** When an MPS accessory is enabled, the Column Status section of the Instrument Window displays cycle numbers (not letters) to represent amino acids.

**Holding or stopping syntheses**

You hold or stop syntheses on the MPS accessory the same way you hold or stop a standard synthesis. See the following sections in the Pioneer Workstation Software Getting Started Guide:

- Section 4.3 Interrupting the Synthesis
- Section 4.4 Stopping the Synthesis
Abort syntheses

Although you cannot hold or stop a synthesis on an individual MPS column, you can abort syntheses on individual MPS columns.

To abort syntheses on individual MPS columns:

1. Press Stat on the Main system menu.
   The Status : Combined menu appears.

2. Press MPS.
   The MPS Status menu appears.

3. Press Column 1 or Column 2.
   The MPS Status Column # display appears.

4. Press the left and right arrow keys to select an MPS column (a through p). Press Abort. Press ok.

5. Repeat step 1 through step 4 to abort a synthesis for any other MPS columns.

   The current cycle completes for selected columns. Subsequent cycles are not completed for selected columns.
2.6 Removing the Columns and the Support

Removing the columns
When the syntheses are complete, remove the columns from the MPS accessory:
1. Disconnect the tubing from the top of the column.
2. Remove the column from the bottom fitting.
3. Insert a union in place of the column.

Removing the support
Use the following procedure to remove the PEG-PS support from the column:
1. Remove the end cap with a decapper.
2. Pour the support out of the column into an appropriate sized tube.
3. Use a spatula to scrape any support off of the walls of the column and frit and transfer the support to the tube.
4. Put the support in a vacuum desiccator until it is completely dry.
 Viewing and Printing Reports

This chapter contains the following sections:

3.1 Viewing Reports ................................. 3-2
3.2 Printing Reports ................................. 3-5
# 3.1 Viewing Reports

**Overview**  
When you send an MPS notebook to the system, the system generates an MPS report. The MPS report is stored in the same folder as the MPS notebook in the database. The MPS report includes the parameters used for the entire set of MPS sequences and lists information about each sequence.

You cannot move or delete reports until the syntheses are completed. You can format reports and edit any comments before the syntheses are completed.

**NOTE:** Add comments to the notebook before you send the MPS notebook to the system if you want the comments to appear on the report. See Section 2.2.4, Entering Comments.

You can view reports from the Database window. You can view a report for all or only one of the sequences. “All” is the default setting.

**Viewing all sequences**

To view all sequences:

1. Access the Database window.
2. Double-click the report icon for the MPS notebook you want to view.

The Report window appears.
Viewing one sequence

To select one sequence to display:

1. From the Database window, double-click the report icon for the MPS notebook you want to view.

   The Report window appears.

2. Select Properties from the File menu or click the Properties button.

3. Click the Sequence tab.

   The Sequence parameters appear (Figure 3-1).

4. Click One.

5. Select the column to display by clicking the up or down arrow.

6. Click OK.

   A report for the selected sequence appears.

---

**Figure 3-1** Sequence Parameters
Customizing  Reports are printed exactly as they are displayed in the Instrument window or Report window. You can customize the parameters that appear on the MPS Report using the Reports Properties dialog box. See the Pioneer Workstation Software Getting Started Guide for more detailed information on customizing reports.
3.2 Printing Reports

**Overview** You can print the following types of MPS reports:

- A combined report for all columns, as displayed in the Report window
- A separate report for each column, as displayed in the Report window

**Printing a combined report** To print a combined report with information for all columns:

1. In the Database window, view the MPS report. See “Viewing all sequences” on page 3-2.

2. Select **Print** from the File menu. The report prints exactly as it is displayed in the Report window.

**Printing separate reports** To print a separate report for selected columns:

1. In the Database window, view the MPS report. See “Viewing all sequences” on page 3-2.

2. Select **Print Multiple** from the File menu. The Print Multiple dialog box appears (Figure 3-2).

![Print Multiple Dialog Box](Image)

*Figure 3-2 Print Multiple Dialog Box*
Chapter 3  Viewing and Printing Reports

3. Select the **MPS columns** for which you want to print a report.

4. Click **OK**.

   A report prints for each selected column that has a report associated with it.
4 Troubleshooting

This chapter contains the following sections:

4.1 Hardware Troubleshooting ......................... 4-2
4.2 Error Messages ........................................ 4-4
Table 4-1 lists the symptoms and possible causes of problems with the mechanical and electronic components of the MPS accessory.

If you are unable to solve problems using the guidelines in the following sections, call Applied Biosystems Technical Support.

### Table 4-1   Hardware Troubleshooting

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>MPS column is leaking</td>
<td>Crimp cap is not on column tightly</td>
<td>Crimp the crimp cap again. See “Assembling” on page 2-17.</td>
</tr>
<tr>
<td>MPS tubing is leaking</td>
<td>MPS fitting is loose</td>
<td>Call Applied Biosystems Technical Support.</td>
</tr>
<tr>
<td>“Column 1 fluid pressure range failure”</td>
<td>Blocked or pinched tubing</td>
<td>Check tubing for obstructions and remove obstruction. Check tubing for pinched areas and straighten. Call Applied Biosystems Technical Support.</td>
</tr>
</tbody>
</table>
**Table 4-1 Hardware Troubleshooting (Continued)**

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>No fluid flowing through MPS column</td>
<td>Blocked or pinched tubing</td>
<td>Check tubing for obstructions and remove obstruction.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check tubing for pinched areas and straighten.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To replace tubing, call Applied Biosystems Technical Support.</td>
</tr>
<tr>
<td></td>
<td>Electronic or valve failure</td>
<td>Call Applied Biosystems Technical Support.</td>
</tr>
</tbody>
</table>
4.2 Error Messages

Table 4-2 describes the error messages that may be displayed during normal operation. Perform the corrective action listed in Table 4-2 before calling Applied Biosystems Technical Support. See back cover of this guide for your area phone number.

**Table 4-2  Error Messages**

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valve Error</td>
<td>Electronic or valve failure</td>
<td>Call Applied Biosystems Technical Support.</td>
</tr>
<tr>
<td>MPS comm. link error</td>
<td>Electronic failure</td>
<td>1. Make sure power cord is connected to a working power source.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Make sure MPS accessory is connected to Pioneer Peptide Synthesis System.</td>
</tr>
<tr>
<td></td>
<td>MPS accessory connected to wrong Pioneer Peptide Synthesis System column. Must be connected to position configured during initial installation.</td>
<td>Make sure MPS accessory is connected to Pioneer Peptide Synthesis System column it is configured for by Applied Biosystems Technical Representative.</td>
</tr>
</tbody>
</table>
Table A-1 lists the specifications for the Multiple Peptide Synthesis accessory.

![Table A-1 Specifications](image)

<table>
<thead>
<tr>
<th>Property</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column positions</td>
<td>Up to 16</td>
</tr>
<tr>
<td>Synthesis strategy</td>
<td>Simultaneous synthesis on all selected columns</td>
</tr>
<tr>
<td>Synthesis cycle time</td>
<td>5 to 20 minutes per amino acid addition depending on number and similarity of sequences</td>
</tr>
<tr>
<td>Synthesis scale/protocol</td>
<td>0.025 mmole, 0.05 mmole, or 0.1 mmole</td>
</tr>
<tr>
<td>Dimensions</td>
<td>• 15.4 inches (39 cm) wide</td>
</tr>
<tr>
<td></td>
<td>• 13 inches (33 cm) deep</td>
</tr>
<tr>
<td></td>
<td>• 5.1 inches (13 cm) high</td>
</tr>
<tr>
<td>External Computer</td>
<td>Requires Pioneer Workstation software (V. 1.1 or later) PC configuration (with RS-422 communication port)</td>
</tr>
</tbody>
</table>
Table A-2 lists the reagent consumption.

**Table A-2  Reagent Consumption**

<table>
<thead>
<tr>
<th>Property</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amino acid consumption</td>
<td>6- to 10-fold excess, depending on scale</td>
</tr>
<tr>
<td>Reagent consumption</td>
<td>Depends on scale</td>
</tr>
<tr>
<td>Reagent capacity</td>
<td>Depends on scale</td>
</tr>
</tbody>
</table>
Table A-3 defines the symbols and default values for the MPS scaling formulas listed in Table A-4.

**Table A-3  MPS Formula Symbol Descriptions**

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Scale (mmoles)</td>
<td>0.05</td>
</tr>
<tr>
<td>V</td>
<td>Activator volume (ml) = S (xs/a)</td>
<td>0.8</td>
</tr>
<tr>
<td></td>
<td>Where: xs = fold excess amino acid</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>a = activator concentration (moles/liter)</td>
<td>0.5</td>
</tr>
<tr>
<td>C</td>
<td>Scaling constant = 4.55WS</td>
<td>1.0</td>
</tr>
<tr>
<td></td>
<td>Where: W = void volume (ml/g)</td>
<td>4.4</td>
</tr>
<tr>
<td>T1, T2</td>
<td>Flow from the MPS Template protocol</td>
<td></td>
</tr>
</tbody>
</table>

Table A-4 contains scaling formulas for the Multiple Peptide Synthesis Accessory.

**Table A-4  MPS Scaling Formulas**

<table>
<thead>
<tr>
<th>Formula Name</th>
<th>Scaling Flow</th>
<th>Scalling Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>[MPS-S2]</td>
<td>T1</td>
<td>C*T2</td>
</tr>
<tr>
<td>[MPS-FILL]</td>
<td>T1</td>
<td>If 120 * V &gt; 96, then 96/T1, else 120 * V/T1</td>
</tr>
<tr>
<td>[MPS-POS]</td>
<td>T1</td>
<td>If 120 * V &gt; 96, then 0, else 96 - 120 * V/T1</td>
</tr>
<tr>
<td>[MPS-ifVx.x]</td>
<td>T1</td>
<td>If V ≥ x.x, then T2, else 0</td>
</tr>
<tr>
<td>[MPS-ACT]</td>
<td>T1</td>
<td>MPS calibration value</td>
</tr>
</tbody>
</table>
This appendix contains part numbers for the spare parts recommended for customer installation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crimper</td>
<td>1</td>
<td>GEN104009</td>
</tr>
<tr>
<td>Decapper</td>
<td>1</td>
<td>GEN104010</td>
</tr>
<tr>
<td>Filter, 20 mm column</td>
<td>40</td>
<td>GEN601305</td>
</tr>
<tr>
<td>N,N-Dimethylformamide (DMF)</td>
<td>4 liters</td>
<td>400143</td>
</tr>
<tr>
<td>Pioneer MPS 50 µM (0.050 mmole) Column Kit</td>
<td>1</td>
<td>GEN601300</td>
</tr>
<tr>
<td>Includes:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 1 crimper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 1 decapper</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 20 MPS columns with end piece</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 40 filters (frits)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 40 crimp caps</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Appendix B  Spare Parts

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pioneer MPS 50 µM (0.050 mmole) Columns</td>
<td>1</td>
<td>GEN601299</td>
</tr>
<tr>
<td>Includes:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 20 MPS columns with end piece</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 40 filters (frits)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• 40 crimp caps</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pioneer MPS Accessory Document Set</td>
<td>1</td>
<td>GEN601302</td>
</tr>
<tr>
<td>Includes:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Pioneer MPS Accessory User’s Guide</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Pioneer MPS Accessory Quick Reference Card</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rack set, amino acid, 28 mm</td>
<td>1</td>
<td>GEN600819</td>
</tr>
<tr>
<td>Seal, crimp, aluminum</td>
<td>1</td>
<td>GEN850216</td>
</tr>
</tbody>
</table>
Applied Biosystems supplies or recommends certain configurations of computer hardware, software, and peripherals for use with its instrumentation. Applied Biosystems reserves the right to decline support for or impose charges for supporting nonstandard computer configurations or components that have not been supplied or recommended by Applied Biosystems. Applied Biosystems also reserves the right to require that computer hardware and software be restored to the standard configuration prior to providing service or technical support. For systems that have built-in computers, installing unauthorized hardware or software may void the Warranty or Service Plan.

C.1 Limited Product Warranty

**Limited warranty**

Applied Biosystems warrants that all standard components of the Pioneer Multiple Peptide Synthesis Accessory will be free of defects in materials and workmanship for a period of ninety (90) days. Applied Biosystems will repair or replace, at its discretion, all defective components during this warranty period. After this warranty period, repairs and replacement components may be purchased from Applied Biosystems at its published rates. Applied Biosystems also provides service agreements for post-warranty coverage. Applied Biosystems
reserves the right to use new, repaired, or refurbished instruments or components for warranty and post-warranty service agreement replacements. Repair or replacement of products or components under warranty does not extend the original warranty period.

Applied Biosystems warrants that all optional accessories supplied with its Pioneer Multiple Peptide Synthesis Accessory, such as peripherals, printers, and special monitors, will be free of defects in materials and workmanship for a period of ninety (90) days. Applied Biosystems will repair or replace, at its discretion, defective accessories during this warranty period. After this warranty period, Applied Biosystems will pass on to the buyer, to the extent that it is permitted to do so, the warranty of the original manufacturer for such accessories.

With the exception of consumable and maintenance items, replaceable products or components used on the instrument are themselves warranted to be free of defects in materials and workmanship for ninety (90) days.

Applied Biosystems warrants that chemicals and other consumable products will be free of defects in materials and workmanship when received by the buyer, but not thereafter, unless otherwise specified in documentation accompanying the product.

Applied Biosystems warrants that for a period of ninety (90) days from the date of installation, the software designated for use with the product will perform substantially in accordance with the function and features described in its accompanying documentation when properly installed on the product. Applied Biosystems does not warrant that the operation of the instrument or software will be uninterrupted or error free. Applied Biosystems will provide any software corrections or “bug-fixes” if and when they become available, for a period of ninety (90) days after installation.
Limited Product Warranty

Warranty period effective date

Any applicable warranty period under these sections will begin on the date of installation for hardware and software installed by Applied Biosystems personnel, unless that date has been delayed at the buyer’s request. In that case, and for all hardware and software installed by the buyer, and for all other products, the applicable warranty period begins the date the component is received by the buyer.

Warranty exceptions

The above warranties shall not apply to defects resulting from misuse, neglect, or accident, including without limitation: operation with incompatible solvents or samples in the system; operation outside of the environmental or use specification instructions for the product or accessories; performance of improper or inadequate maintenance by the user; installation of software or interfacing not supplied by Applied Biosystems; and modification or repair of the product or the software not authorized by Applied Biosystems.

The foregoing provisions set forth Applied Biosystems’ sole and exclusive representations, warranties, and obligations with respect to its products, and Applied Biosystems makes no other warranty of any kind whatsoever, expressed or implied, including without limitation, warranties of merchantability and fitness for a particular purpose, whether arising from a statute or otherwise in law or from a course of dealing or usage of trade, all of which are expressly disclaimed. Such limited warranty is given only to buyer or any third party in the event of use of products furnished hereunder by any third party.

Warranty limitations

The remedies provided herein are the buyer’s sole and exclusive remedies. Without limiting the generality of the foregoing, in no event shall Applied Biosystems be liable, whether in contract, in tort, warranty, or under any statute (including without limitation, any trade practice, unfair competition, or other statute of similar import) or on any other basis, for direct, indirect, punitive, incidental, multiple, consequential, or special damages sustained by the buyer or any other person, whether or not foreseeable and whether or not Applied Biosystems is advised of the possibility of such damage, including without limitation, damage arising from or
related to loss of use, loss of data, failure or interruption in the operation of any equipment or software, delay in repair or replacement, or for loss of revenue or profits, loss of good will, loss of business or other financial loss or personal injury or property damage.

No agent, employee, or representative of Applied Biosystems has any authority to bind Applied Biosystems to any affirmation, representation, or warranty concerning the product that is not contained in this Limited Warranty Statement. Any such affirmation, representation, or warranty made by any agent, employee, or representative of Applied Biosystems will not be binding on Applied Biosystems.

This warranty is limited to the buyer of the product from Applied Biosystems and is not transferable.

C.2 Damages, Claims, Returns

**Damages** If shipping damage to the instrument is discovered, contact the shipping carrier and request inspection by a local agent. Secure a written report of the findings to support any claim. Do not return damaged goods to Applied Biosystems without first securing an inspection report and contacting Applied Biosystems Technical Support for a Return Authorization (RA) number.

**Claims** After a damage inspection report is secured, Applied Biosystems will supply the replacements and process claims that are initiated by either party.

**Returns** Do not return any material without prior notification and authorization.

If for any reason it becomes necessary to return material to Applied Biosystems, contact Applied Biosystems Technical Support or your nearest Applied Biosystems subsidiary or distributor for a return authorization (RA) number and forwarding address. Place the RA number in a prominent location on the outside of the shipping container, and return the material to the appropriate address.
MPS Calibration

Overview of MPS calibration value

The MPS calibration value is the time required for air bubbles to travel from the Pioneer System to the MPS accessory. The calibration value is affected by the length of tubing and differences in the internal diameter of tubing.

The MPS calibration value is entered in the system software and determines the duration of a step in MPS protocols. This calibration value allows for the precise positioning of reagents on the MPS column and is critical to a successful synthesis using the MPS accessory.

NOTE: Record this MPS calibration value so you have it available if you need to reset the MPS calibration value.

When to determine and reset the MPS calibration value

The MPS calibration value is determined and set for your Pioneer System when it is initially installed by an Applied Biosystems Service Representative.

You need to determine and reset the MPS calibration value if you:

- Install a new version of software
- Reset the Random Access Memory (RAM)
- Modify or replace the tubing between the Pioneer System and the MPS accessory
- Replace a battery in the system
Determining the MPS calibration value

**NOTE:** If you did not modify or replace tubing and recorded the original MPS calibration value, you do not need to determine a new MPS calibration value.

To determine the MPS calibration value:

1. On the system display, press **Prime** on the Main menu. The Prime menu appears.
2. Press **More**. The second Prime menu appears (Figure D-1).

![Prime Menu](image)

**Figure D-1** Prime Menu

4. Press the column position to which your MPS accessory is connected, **Column 1** or **Column 2**. The Position Selection display appears (Figure D-2).

![Position Selection Display](image)

**Figure D-2** Position Selection Display
5. Using the arrow keys, toggle the position selection to a and press **OK**.
   
The system prompts: Position wash station under the probe.

6. If the wash station is not in the sampling position under the probe, press **Stop**, then **End** to position the wash station. Press **Repeat**.

7. Press **OK**.
   
The system prompts: Put union in column positions.

8. Replace column a with a union and press **OK**.
   
The system fills the wash station and primes the lines, and the Prime/Manual : Status display appears (Figure D-3).

9. Press **OK**.
   
The system starts pumping air through the lines and a second Prime/Manual : Status display appears (Figure D-4).

---

**Figure D-3** Prime/Manual : Status Display

**Figure D-4** Prime/Manual : Status Display
10. Watch the outlet tubing at the column a position closely. When a steady stream of gas bubbles appears in the coupling, press Stop.

**NOTE:** You may see small bubbles pass through the line. However, do not press Stop until you see a steady stream of bubbles.

11. Record the MPS calibration value (seconds) displayed in the upper left corner of the display.

The value should be about 20 to 30 seconds.

12. Press Repeat to perform the calibration again. Repeat the calibration for column a until you achieve the same result three consecutive times.

13. Press cancel, then More, and repeat the procedure for column p until you achieve the same result three consecutive times.

The final MPS calibration value is the larger of the two calibration values you obtained for column a and p.

14. When the calibration is finished, press Cancel and then press Exit to return to the system Main menu.
**Entering the MPS calibration value in the system**

To enter the MPS calibration value in the Pioneer System software:

1. On the system display, press **Tools** on the Main menu.
2. Press **Diag**.

   The Diagnostics menu appears (Figure D-5).

   ![Figure D-5 Diagnostics Menu](image)

3. Press **MPS**.

   The MPS Delivery Calibration display appears (Figure D-6).

   ![Figure D-6 MPS Delivery Calibration Display](image)

4. Using the arrow keys, toggle the **Current value** to the MPS calibration value you determined in the previous procedure.

5. Press **ok** to save the changes and return to the Diagnostics menu.
This appendix contains the following sections:

E.1 Contacting Technical Support ......................... E-2
E.2 Obtaining Technical Documents...................... E-8
E.3 Obtaining Customer Training Information..... E-10
E.1 Contacting Technical Support

**Overview**  You can contact Applied Biosystems for technical support:

- By e-mail
- By telephone or fax
- Through the Applied Biosystems web site

**NOTE:** For information on obtaining technical documents such as Applied Biosystems user documents, MSDSs, and certificates of analysis, see “Obtaining Technical Documents” on page E-8.

**By E-mail**  You can contact technical support by e-mail for help in the product areas listed below.

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>E-Mail Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Genetic Analysis (DNA Sequencing)</td>
<td><a href="mailto:galab@appliedbiosystems.com">galab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Sequence Detection Systems and PCR</td>
<td><a href="mailto:pcrlab@appliedbiosystems.com">pcrlab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>Protein Sequencing, Peptide, and DNA Synthesis</td>
<td><a href="mailto:corelab@appliedbiosystems.com">corelab@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>• Biochromatography</td>
<td><a href="mailto:tsupport@appliedbiosystems.com">tsupport@appliedbiosystems.com</a></td>
</tr>
<tr>
<td>• Expedite™ (8900) DNA Synthesis System</td>
<td></td>
</tr>
<tr>
<td>• PNA</td>
<td></td>
</tr>
<tr>
<td>• Pioneer™ Peptide Synthesis System</td>
<td></td>
</tr>
<tr>
<td>• Proteomics Solution 1™ (PS1) System</td>
<td></td>
</tr>
<tr>
<td>• ICAT™ reagent</td>
<td></td>
</tr>
<tr>
<td>• FMAT™ 8100 HTS System</td>
<td></td>
</tr>
<tr>
<td>• Mariner™ Mass Spectrometers</td>
<td></td>
</tr>
<tr>
<td>• Voyager™ Mass Spectrometers</td>
<td></td>
</tr>
<tr>
<td>• CytoFluo® 4000 Fluorescence Plate Reader</td>
<td></td>
</tr>
<tr>
<td>LC/MS (Applied Biosystems/MDS Sciex)</td>
<td><a href="mailto:support@sciex.com">support@sciex.com</a></td>
</tr>
<tr>
<td>Chemiluminescence (Tropix)</td>
<td><a href="mailto:tropix@appliedbiosystems.com">tropix@appliedbiosystems.com</a></td>
</tr>
</tbody>
</table>
To contact Applied Biosystems Technical Support in North America, use the telephone or fax numbers in the table below.

**NOTE:** To schedule a service call for other support needs, or in case of an emergency, dial **1.800.831.6844**, then press **1**.

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABI PRISM® 3700 DNA Analyzer</td>
<td>1.800.831.6844, then press 8&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>DNA Synthesis</td>
<td>1.800.831.6844, press 2, then press 1&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>Fluorescent DNA Sequencing</td>
<td>1.800.831.6844, press 2, then press 2&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>Fluorescent Fragment Analysis (including GeneScan® applications)</td>
<td>1.800.831.6844, press 2, then press 3&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>Integrated Thermal Cyclers (ABI PRISM® 877 and Catalyst 800 instruments)</td>
<td>1.800.831.6844, press 2, then press 4&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>ABI PRISM® 3100 Genetic Analyzer</td>
<td>1.800.831.6844, press 2, then press 6&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>Peptide Synthesis (433 and 43x Systems)</td>
<td>1.800.831.6844, press 3, then press 1&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
<tr>
<td>Protein Sequencing (Procise® Protein Sequencing Systems)</td>
<td>1.800.831.6844, press 3, then press 2&lt;sup&gt;a&lt;/sup&gt;</td>
<td>1.650.638.5981</td>
</tr>
</tbody>
</table>
### Appendix E  Technical Support and Training

<table>
<thead>
<tr>
<th>Product/Product Area</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCR and Sequence Detection</td>
<td>1.800.762.4001, then press:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 for PCR&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 for TaqMan&lt;sup&gt;®&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>applications and Sequence Detection Systems including ABI Prism&lt;sup&gt;®&lt;/sup&gt; 7700, 7900, and 5700&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6 for the 6700 Automated Sample Prep System&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.800.831.6844, then press 5&lt;sup&gt;a&lt;/sup&gt;</td>
<td></td>
</tr>
<tr>
<td>• Voyager&lt;sup&gt;™&lt;/sup&gt; MALDI-TOF Biospectrometry Workstations</td>
<td>1.800.899.5858, press 1, then press 3&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.7855</td>
</tr>
<tr>
<td>• Mariner&lt;sup&gt;™&lt;/sup&gt; ESI-TOF Mass Spectrometry Workstations</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Proteomics Solution 1&lt;sup&gt;™&lt;/sup&gt; (PS1) System</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• ICAT&lt;sup&gt;™&lt;/sup&gt; reagent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Biochromatography (BioCAD&lt;sup&gt;®&lt;/sup&gt;, SPRINT&lt;sup&gt;™&lt;/sup&gt;, VISION&lt;sup&gt;™&lt;/sup&gt;, and INTEGRAL&lt;sup&gt;®&lt;/sup&gt; Workstations and POROS&lt;sup&gt;®&lt;/sup&gt; Perfusion Chromatography Products)</td>
<td>1.800.899.5858, press 1, then press 4&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.7855</td>
</tr>
<tr>
<td>Expedite&lt;sup&gt;™&lt;/sup&gt; (8900) Nucleic Acid Synthesis Systems</td>
<td>1.800.899.5858, press 1, then press 5&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.7855</td>
</tr>
<tr>
<td>Peptide Synthesis (Pioneer&lt;sup&gt;™&lt;/sup&gt; and 9050 Plus Peptide Synthesizers)</td>
<td>1.800.899.5858, press 1, then press 5&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.7855</td>
</tr>
<tr>
<td>PNA Custom and Synthesis</td>
<td>1.800.899.5858, press 1, then press 5&lt;sup&gt;b&lt;/sup&gt;</td>
<td>1.508.383.7855</td>
</tr>
</tbody>
</table>


By telephone or fax (outside North America)

To contact Applied Biosystems Technical Support or Field Service outside North America, use the telephone or fax numbers below.

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eastern Asia, China, Oceania</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Australia (Scoresby, Victoria)</td>
<td>61 3 9730 8600</td>
<td>61 3 9730 8799</td>
</tr>
<tr>
<td>China (Beijing)</td>
<td>86 10 64106608 or 64106617</td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>852 2756 6928</td>
<td>852 2756 6968</td>
</tr>
<tr>
<td>Korea (Seoul)</td>
<td>82 2 5936470/6471</td>
<td>82 2 5936472</td>
</tr>
<tr>
<td>Malaysia (Petaling Jaya)</td>
<td>60 3 79588268</td>
<td>603 79549043</td>
</tr>
<tr>
<td>Singapore</td>
<td>65 896 2168</td>
<td>65 896 2147</td>
</tr>
<tr>
<td>Taiwan (Taipei Hsien)</td>
<td>886 2 2358 2838</td>
<td>886 2 2358 2839</td>
</tr>
<tr>
<td>Thailand (Bangkok)</td>
<td>66 2 719 6405</td>
<td>662 319 9788</td>
</tr>
</tbody>
</table>
### Technical Support and Training

#### Region | Telephone | Fax
---|---|---
**Europe**
Austria (Wien) | 43 (0)1 867 35 75 00 | 43 (0)1 867 35 75 11
Belgium | 32 (0)2 532 4484 | 32 (0)2 582 1886
Denmark (Naerum) | 45 45 58 60 00 | 45 45 58 60 01
Finland (Espoo) | 358 (0)9 251 24 250 | 358 (0)9 251 24 243
France (Paris) | 33 (0)1 69 59 85 85 | 33 (0)1 69 59 85 00
Germany (Weiterstadt) | 49 (0) 6150 101 0 | 49 (0) 6150 101 101
Italy (Milano) | 39 (0)39 83891 | 39 (0)39 838 9492
Norway (Oslo) | 47 23 12 06 05 | 47 23 12 05 75
Portugal (Lisboa) | 351.(0)22.605.33.14 | 351.(0)22.605.33.15
Spain (Tres Cantos) | 34.(0)91.806.1210 | 34.(0)91.806.12.06
Sweden (Stockholm) | 46 (0)8 619 4400 | 46 (0)8 619 4401
Switzerland (Rotkreuz) | 41 (0)41 799 7777 | 41 (0)41 790 0676
The Netherlands (Nieuwerkerk a/d IJssel) | 31 (0)180 392400 | 31 (0)180 392409 or 31 (0)180 392499
United Kingdom (Warrington, Cheshire) | 44 (0)1925 825650 | 44 (0)1925 282502
**European Managed Territories (EMT)**
Africa, English speaking (Johannesburg, South Africa) | 27 11 478 0411 | 27 11 478 0349
Africa, French speaking (Paris, France) | 33 1 69 59 85 11 | 33 1 69 59 85 00
India (New Delhi) | 91 11 653 3743 | 91 11 653 3138
Poland, Lithuania, Latvia, and Estonia (Warszawa) | 48 22 866 4010 | 48 22 866 4020
To contact Technical Support through the Applied Biosystems web site:

1. Go to www.appliedbiosystems.com
2. Click Services & Support at the top of the page, then click Frequently Asked Questions.
3. Click Contact Support in the contents list at the left of the screen.
4. Click your geographic region for the product area of interest.
5. In the Personal Assistance form, enter the requested information and your question, then click Ask Us RIGHT NOW.
6. In the Customer Information form, enter the requested information, then click Ask Us RIGHT NOW.

Within 24 to 48 hours, you will receive an e-mail reply to your question from an Applied Biosystems technical expert.

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone</th>
<th>Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>For all other EMT countries not listed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(Central and southeast Europe, CIS, Middle East, and West Asia)</td>
<td>44 1925 282481</td>
<td>44 1925 282509</td>
</tr>
<tr>
<td>Japan</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Japan (Hacchobori, ChuoKu, Tokyo)</td>
<td>81 3 5566 6230</td>
<td>81 3 5566 6507</td>
</tr>
<tr>
<td>Latin America</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Caribbean countries, Mexico, and Central America</td>
<td>52 55 35 3610</td>
<td>52 55 66 2308</td>
</tr>
<tr>
<td>Brazil</td>
<td>0 800 704 9004 or</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td></td>
<td>55 11 5070 9654</td>
<td></td>
</tr>
<tr>
<td>Argentina</td>
<td>800 666 0096</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td>Chile</td>
<td>1230 020 9102</td>
<td>55 11 5070 9694/95</td>
</tr>
<tr>
<td>Uruguay</td>
<td>0004 055 654</td>
<td>55 11 5070 9694/95</td>
</tr>
</tbody>
</table>
E.2 Obtaining Technical Documents

**Overview**
You can obtain technical documents, such as Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents for free, 24 hours a day. You can obtain documents:
- By telephone
- Through the Applied Biosystems web site

**Ordering documents by telephone**
To order documents by telephone:
1. From the U.S. or Canada, dial 1.800.487.6809, or from outside the U.S. and Canada, dial 1.858.712.0317.
2. Follow the voice instructions to order documents (for delivery by fax).

**NOTE:** There is a limit of five documents per fax request.

**Obtaining documents through the web site**
To view, download, or order documents through the Applied Biosystems web site:
2. At the top of the page, click Services & Support at the top of the page, then click Documents on Demand.
3. In the search form, enter and select search criteria, then click Search at the bottom of the page.
4. In the results screen, do any of the following:
   - Click 📄 to view a PDF version of the document.
   - Right-click 📄, then select Save Target As to download a copy of the PDF file.
   - Select the Fax check box, then click Deliver Selected Documents Now to have the document faxed to you.
   - Select the Email check box, then click Deliver Selected Documents Now to have the document (PDF format) e-mailed to you.
NOTE: There is a limit of five documents per fax request, but no limit on the number of documents per e-mail request.
E.3 Obtaining Customer Training Information

To obtain Applied Biosystems training information, go to www.appliedbiosystems.com, click Services & Support at the top of the screen, then click Training.
Index

A
Aborting a synthesis 2-33
Activator, selecting 2-7
Adding comments 2-11
Amino acid
  concentration 2-23
  consumption A-2
  if more than one tube required 2-24
  installing 2-23, 2-24
  maximum number 1-3
  positions 2-24
  printing reports for 3-5
  total number used 1-3
  viewing reports for 3-2
  weight and solvent volumes 2-23
Assembling column 2-16
Audio playback 2-10
Autofilling sequence options 2-10

B
Blocked tubing 4-2, 4-3
Bottle volume, resetting 2-21, 2-22

C
Calibration D-1
  checking value 2-20
  determining value D-2
  entering value in system D-5
Capacity, reagent A-2
Certificates of analysis obtaining E-8
Chemistry, editing 2-6
Column
  assembling 2-16
  connections 2-28
  installing 2-28, 2-29
  leaking 4-2
  maximum number of 1-2
  number of positions 1-2, A-1
  packing 2-18
  parts 2-16
  position diagram 2-28
  preparing 2-16
  removing 2-34
  sizes 2-16
  support weights 2-16
  troubleshooting 4-2
Column fluid pressure warning 4-2
Comments 2-11
  editing 3-2
  entering 2-11
Computer
  configuration requirement C-1
  requirements A-1
  technical support for altered configuration C-1
Concentration of amino acids 2-23
Connections
  column 2-28
  front panel 1-8
Consumption
  amino acid A-2
  reagent 2-12, A-2
Copying
  MPS notebook 2-5
  sequence 2-9, 2-10
Creating
  MPS notebook 2-4
  sequence 2-7
C-terminus option
  autofilling 2-10
  selecting 2-8, 2-9, 2-10
Customer training, information E-10
Customizing reports 3-4
Cycle
  selecting 2-7
  time specification A-1

Damage, reporting C-4
Deleting sequence from MPS notebook 2-10
Dimensions A-1
Disabling
  MPS accessory 1-5
  Synthesis checklist 2-15

Editing
  chemistry 2-6
  protocol 2-6
Enabling the MPS accessory 1-5, 1-9
Entering
  comments 2-11
  sequences 2-7
  synthesis parameters 2-6
Error messages
  MPS comm. link 4-4
  Troubleshooting table
  Valve 4-4

Field Service in North America, contacting E-3
Final cycle option, selecting 2-7
First AA option
  autofilling 2-10
  selecting 2-9, 2-10
Front panel connections 1-8

Hardware troubleshooting 4-2
Help, see Technical support
Holding a synthesis 2-32
How to use this guide ix

Importing MPS notebook 2-6
Installing
  amino acids 2-23, 2-24
  columns 2-28, 2-29
  MPS accessory 1-4

Leaking
  column 4-2
  tubing 4-2

Molecular weight of peptide 2-12
Monitoring synthesis 2-32
MPS accessory
  changing column position 1-4
  controlling with software 1-4
  description 1-2
  disabling 1-5
  enabling 1-5, 1-9
  features 1-4
  installing 1-4
  introduction 1-2
  overview 1-2
  parts of 1-4
  placement 1-2
  priming 2-25
  reconfiguring 1-4
  software needed 1-4
MPS calibration
   checking value 2-20
   determining value D-2
   entering value in system D-5
MPS notebook 2-11
   autofilling sequence options 2-10
   comments 2-11
   contents 2-3
   copying 2-5
   creating 2-4
   deleting sequence 2-10
   entering sequence 2-7
   entering synthesis parameters 2-6
   icon 2-4
   importing 2-6
   opening 2-5
   sending 2-14
   sequence, copying or cutting 2-9
   verifying sequence 2-10
MPS notebook view 2-8
MPS Option, setting 1-5, 1-7, 1-9
MPS protocol 2-6
MPS report
   customizing 3-4
   icon 3-2, 3-3
   individual 3-5
   overview 3-2
   printing 3-5
   summary 3-5
   viewing 3-2
MPS sequence view 2-7
MSDSs, obtaining E-8
Multiple Peptide Synthesis accessory
   formula symbols A-2
   scaling formulas A-3
Multiple Peptide Synthesis Calculation Sheet
   magnifying 2-12
   printing 2-13
   viewing 2-12

N
No fluid through column 4-3
Notebook, see MPS notebook

O
Opening MPS notebook 2-5
Overview
   MPS report 3-2
   Overview, synthesis 2-2

P
Packing the column 2-18
Part numbers B-1
Parts
   of MPS accessory 1-4
   ordering B-1
PEG-PS
   maximum weight 2-16
   removing from column 2-34
Peptide length 2-12
Peptide Synthesis Calculation Sheet, see Multiple Peptide Synthesis Calculation Sheet
Peptides, maximum number synthesized 1-2
Performance Specifications A-1
Performing a synthesis 2-2
Pinched tubing 4-2, 4-3
Playback, audio 2-10
Preface ix
Preparing
   columns 2-16
   system 2-15, 2-19
Priming
   information 2-31
   MPS accessory 2-25
   status 2-31
system 2-25
Printing
  amino acid weights and volumes 2-13, 2-19
  MPS reports 3-5
  Multiple Peptide Synthesis Calculation Sheet 2-13, 2-19
  reagent requirements 2-19
Protocol, MPS 2-6

 RA number C-4
Reagent
  capacity A-2
  checking resources 2-21
  consumption 2-12, A-2
  replenishing 2-21
  required volume 2-21
  requirements, printing 2-19
  resetting bottle volume 2-21
  updating 2-21
Reconfiguring MPS accessory 1-4
Related documents xii
Removing
  columns 2-34
  support 2-34
Replenishing reagents 2-21, 2-22
Report, see MPS report
Required space A-1
Requirements
  reagent 2-21
  software 1-4
  space A-1
Resetting bottle volume 2-21, 2-22
Resource Calculation Sheet, see Multiple Peptide Synthesis Calculation Sheet
Returning damaged items C-4

Scale, setting 2-7
Selecting
  activator 2-7
  chemistry 2-7
  column sizes 2-16
  cycle 2-7
  final cycle 2-7
  first AA option 2-9, 2-10
  MPS protocol 2-7
  scale 2-7
Sending MPS notebook 2-14
Sequence view, see MPS sequence view
Sequences
  audio playback 2-10
  autofilling options 2-10
  copying 2-9, 2-10
  creating 2-7
  deleting 2-10
  entering 2-7
  printing 3-5
  verifying 2-10
  viewing 3-2
Software
  controlling 1-4
  Pioneer Workstation 1-4
  required version 1-4
  requirements
    Software
      Pioneer System 1-4
Solving problems 4-2
Space requirements 1-2, A-1
Spare parts B-1
Specifications A-1
Status, monitoring 2-32
Steps in synthesis 2-2
Stopping synthesis 2-32, 2-33
Support
  parameters, printing 2-12
removing 2-34
weight and column size 2-16
weight needed 2-16, 2-18

Synthesis
aborting 2-33
monitoring 2-32
number of columns 2-2
overview 2-2
performing 2-2
preparing system 2-19
priming before 2-25
sending to system 2-14
specifications A-1
starting 2-32
status 2-32
steps 2-2
stopping or holding 2-32
time estimate 2-12

Synthesis Checklist Wizard,
   disabling 2-15
Synthesis parameters, entering in
   notebook 2-6
System
preparing 2-15, 2-19
priming 2-25
sending MPS notebook to 2-14

T
Technical documents, obtaining E-8
Technical support
   for computers with altered
   configuration C-1
Technical support, contacting
   Eastern Asia, China, Oceania E-5
   Europe E-6
   Japan E-7
   Latin America E-7
   telephone or fax in North America E-3
Time estimate, synthesis 2-12

Troubleshooting
   error messages 4-4
   hardware 4-2
Tubing
   blocked or pinched 4-2, 4-3
   connecting 1-9
   disconnecting 1-8
   leaking 4-2

U
User Profile
   disabling MPS 1-5, 1-7
   enabling MPS 1-9

V
Verifying sequence from MPS
   notebook 2-10
Viewing
   MPS reports 3-2
   Multiple Peptide Synthesis
   Calculation Sheet 2-12
   sequences 3-2

W
Warning
   see Error messages
Column fluid pressure range 4-2
Warranty
   damages, claims, returns C-4
   exceptions C-3
   for computers with altered
   configuration C-1
   period C-1
Warranty information C-1
Waste
   emptying 2-31
   generation 2-12
Weight
  amino acid 2-12, 2-23
  support 2-12, 2-16, 2-18
Window, MPS notebook 2-3